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EDITORIAL
Welcome to the latest edition of Australian Videocamera!
Not since Australian Videocamera went “digital” have we had an issue as big or as diverse as this one. There truly
should be something for everyone in this latest Australian Videocamera.
The professional cammo I am sure will be more than interested in Dr David Smith’s in-depth look at the Blackmagic Design URSA Broadcast camera married to an awesome new Fujinon lens specifically designed for URSA.
Editors I hope will find my look at single or dual monitor displays of interest, and also get an insight into what
editing with a dedicated keyboard is like (and perhaps be tempted to also have a play with DaVinci Resolve as a
consequence).
Denby Smith is back with his second in the Cinema 4D tutorial series, and now you really start to get your hands
dirty building a “spaceport” in 3D space
For the action enthusiasts, we have a look at audio options for action cameras and also test drive the latest DJI
drone, the MAVIC Mini. Finally, in a new segment we hope you will contribute to, I discuss what my shooting
setup is and what gear I use.
As always, if you have any suggestions, comments or criticisms, feel free to contact me via david@auscamonline.com.

Contact Us
Phone:
+61 (0)456952227
Email:
david@auscamonline.com

Web:

australian-videocamera.com

Facebook:

AustralianVideocamera

Twitter:
@Auscamonline

And don’t forget as well as our website, we are also on Facebook, Twitter and Instagram! Just search for Australian Videocamera.

Instagram:

Until next month, happy shooting!
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CAMCORDER

EXCLUSIVE: Review Blackmagic Design URSA
PART I – URSA Broadcast camera

No-one objects to paying a reasonable amount for their software – proince its inception in 2001,
vided you get to own it – but having
Blackmagic
Design
has
the software die when you can longearned an enviable reputation for
er afford the subscription is frankly
producing high-end digital movie
appalling. More power to the likes
cameras and associated studio
of Blackmagic
hardware. They also released – in
Design.

S

a surprise move – a fully featured
non-linear editing suite called Da Blackmagic
Vinci Resolve that sold for precise- Design camly nothing: it was free.
eras have alPaying for the full version added just
a few crucial components that linked
the software to the Blackmagic hardware elements but the free version is
95 percent complete. Several other
companies have followed this lead,
releasing either free or very cheap
NLE software.

ways
been
distinctly innovative, taking
heed of the
requirements
of
professionals
and integrating them into cameras
that are not only great to use but remarkably affordable.

line them for ease of use
and portability.

The result is a beautifully
built camera body that
This is a fantastic move on their part
retails for AUD$5,695 and
This
is
certainly
the
case
with
the
and flies in the face of the detestable
can be matched to a wide range of
newly
released
URSA
Broadcast
kit
ransomware subscription model en4K and Full HD lenses, but especially
designed
to
take
the
best
features
of
forced by companies like Adobe.
the Fujinon LA16x8BR reviewed here,
the original URSA range and streamPAGE 4
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by Dr David Smith

A Broadcast with Fujinon LA16X8 Zoom Lens
which was designed specifically as a partner for the URSA
Broadcast.
I review

dio applications.

cording or input to a studio mixer.

The URSA body is solidly constructed
with nine 1/4" x20 screw sockets for
attaching accessories such as monitors, lights and microphones. The
camera has its own inbuilt stereo
mics as well as XLR inputs for external
microphones. There is a beautiful Full
HD LCD touchscreen with razor sharp
menu items that are clear and logically laid out.

One of the many brilliant design features of the URSA Broadcast is its flexibility and related affordability. Recording is to either CFast 2.0 or SD/
UHS-II cards, both of which are readily
available. CFast allows recording up
to 4K Blackmagic RAW and ProRes,
whereas SD/UHS-II cards are fine for
Full HD and Ultra HD recording.

When this screen is closed, well
sealed with an O-ring to protect
the various memory card slots, all
critical shooting information is displayed on a bright LCD screen
along with buttons and dials for all
key functions including audio levels.

this lens sepa- rately but suf- fice
to say the URSA/Fujinon combination
is a real winner for both field and stu-

Outputs are via a 3G SDI socket at
the front providing HD output for the
viewfinder, studio or other monitors,
and a 12G SDI terminal at the back
providing a 4K signal suitable for re-

A 128GB CFast 2 card will set you
back around AUD$550 whereas the
same capacity SD/UHS-II card sells for
around AUD$200. There are two slots
for each type of card and, as always,
the better and faster the card specs,
the higher the supported resolution.
Similarly for lenses. The B4 lens mount
allows you to use existing HD or UHD
lenses although several optional lens
mounts are available from Blackmagic so you can use a wide range of still
camera and other video lenses. As
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always it is important to check your
own lenses carefully to ensure they
will work well with the URSA's UHD
sensor. Although many good quality
HD lenses will resolve up to 2K or even
3K resolution, some lenses will show
marked drop-offs in both chromatic
and resolution performance when
viewed in 4K as you move towards
the corners of the frame.

Using the URSA Broadcast
This is a serious video camera and as
such it is not a lightweight. With lens,
viewfinder, microphone, battery and
shoulder adapter the URSA broadcast weighs in at more than seven
kilograms. You can hand-hold it but
you need to be fit to do so for any extended period of time. My son Denby
has used one of these to film football
matches and, even though he works
out, after two hours he really feels
the strain. No problems on a tripod,
though and likewise in a studio setting.
The LCD menu system is clear and
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everything, I do worry about 4K cameras that have air vents on top and
er can easily be adjusted fore and underneath the body. I appreciate
aft as well as laterally and there is a that these systems inevitably get hot
wide range of dioptre adjustment to in use, so some kind of efficient ventisuit your own eyes. For some reason lation is essential.
the rubber eyecup was a bit prone to
But the vents worry me: it would be
falling off. That may relate to this benear impossible to prevent sand, dust
ing a demo camera but I hope that
and rain dropping into these and I
wouldn't be the case with a new one.
wonder what that would do to exWith the Fujinon 16:1 zoom lens in posed internals and electronics. In
place the camera is well balanced wild conditions I normally use a rain
and all important controls fall eas- jacket to protect the camera but
ily to hand. After a couple of shoots would this prevent adequate airflow
I would feel totally at home with this leading to overheating?
logical and the LCD screen is crystal
clear, even in daylight. The viewfind-

camera.
I have just a couple of minor quibbles. The audio volume knobs on the
left hand side are infinitely adjustable; I would definitely prefer the more
usual calibrated ones so you can see
your volume settings at a glance.
Given the kind of filming locations
I often find myself in, including arid
dusty landscapes and beaches with
wind, sand and salt spray covering

This is a vulnerability that I would want
to address before taking this otherwise beautiful camera down to a surf
beach in a storm surge. Perhaps air
vents opening sideways and protected beneath a cover strip would be
an improvement?
Blackmagic Design are continually
improving the software and firmware
for the camera and these updates
can be accessed via the USB-C port.

CAMCORDER

PART II Fujinon LA16X8 zoom lens
No matter how good your image
sensor, it will always be limited by the
light rays presented to it, ie by the
lens. I have loved high quality lenses
since my childhood. My father and
my uncle – who worked as a Kodak
engineer in Melbourne – both took
their stills photography very seriously.
Both had German Exakta 35mm SLR
cameras with their superb Carl Zeiss
optics. Later, when filming my own
documentaries, I used an Arriflex
16mm film camera with a beautiful
Angenieux 20:1 zoom lens.
When I got the chance to review the
URSA Broadcast kit I was as excited to
try out the camera as I was to check
out the Fujinon 16:1 zoom lens. Supplied with a 2/3" B4 bayonet which
matches that on the URSA, the lens
is designed as the perfect partner for
the URSA Broadcast camera.

tures clearly labelled, well placed
and delightful to use. The focus ring
has just the right 'feel' and resistance
for fine control, the zoom ring has a
small lever which is useful and the aperture ring is placed right where you
need it.

The handgrip is well designed and
has switches on top for Manual or
Auto Iris as well as a Push Auto button. There's also a large variable
zoom rocker handle, all of these
switches being well positioned for effortless use during the challenges of
real-world shooting.

Geared rings are provided for either
The one I am reviewing is the LA16x- manual or servo-controlled follow fo- On the underside of the handle is a
Manual/Servo zoom selector and a
8BRM-XB1A. This is a beautifully craft- cus, zoom and aperture.
very useful Flange Back Focus adjusted lens with all of the important feaPAGE 7
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ment button labelled Ff. Back Focus
is achieved electronically and is faster and more precise than doing this
manually. You press and hold the Ff
button down for at least five seconds
then release it. The lens will zoom in
fully to your test chart. Adjust focus
then press the button again. Now
the lens will zoom out to full wide.
Adjust the focus once more and

you're done.
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You can now zoom anywhere in
the entire range and the lens will be
sharply focused. It is crucial to perform this adjustment whenever a new
lens is mounted and it's advisable to
check Back Focus from time to time
to ensure you have perfect focus
throughout the entire zoom range.

optimised for 4K capture. However,
in combination with the URSA Broadcast camera, you will achieve excellent results in either Full HD or 4K
mode. Interestingly, the URSA camera features a 1 inch sensor which
makes critical focusing less risky when
shooting 'on the fly' than with a full
frame sensor.

This 16:1 zoom lens has a maximum
aperture of just 1.9 at the widest A four-position wheel on the URSA
zoom of 8mm (2.8 at 128mm)and is offers three ND options, namely 2, 4

CAMCORDER
• URSA Mini Shoulder Kit AUD$500
• URSA Mini Microphone Mount
Even more helpful is the inbuilt macro
AUD$200
option. This is an excellent camera
• URSA VLock Battery Plate AUD$165
offering a wide range of professional
• Anton Bauer 90 V-mount battery
features at a very competitive price.
AUD$495
• EF or PL lens mounts AUD$250 Essential Accessories
This reduces the Minimum Object
$500
Distance from 800mm to just 50mm Depending on how you plan to use
making macro-cinematography eas- the URSA Broadcast, there are many
tailor-made options available to you.
ily achievable.
Total for basic studio/field kit approx.
You can easily use the basic URSA AUD$18,000
Conclusion
body with its excellent LCD screen
The URSA Broadcast kit with Fujinon
and just the lens fitted, although the EDITOR'S NOTE:
16:1 zoom lens is a cleverly designed,
addition of a viewfinder, battery and
well implemented camera suitable
plate, and shoulder mount kit are We did check with Blackmagic Design refor a wide variety of uses, from docupretty much givens as essential ac- garding David Smith's concern about the
mentaries to ENG to studio produccessories.
cooling capabilities of the URSA Broadtions. It offers great flexibility ranging
from Full HD right through to RAW Here are the approximate costs al- cast due to the design. We are assured by
capture and with several custom though there are sure to be discount- Blackmagic Design there has never been
a problem even in locations and environmade lens adaptors, allows you to ed options available soon.
ments as diverse as the Amazon jungle and
use many of your current HD or DSLR
• Fujinon LA16x8 16:1 zoom lens extreme desert heat. If a raincoat is added,
lenses with great results.
AUD$5,500 (ex GST)
there will also be no issues with cooling we
The recommended Fujinon lens is su- • URSA Broadcast $5,695
are told.
perb and covers a useful range of focal lengths. It is a fast lens at f=1.9 at • URSA Viewfinder AUD$2,449
the widest zoom, ranging up to just • URSA Studio Viewfinder AUD$2,684
and 6 stops. There is no optical doubler available on the lens. One excellent feature of this lens is the simple Macro function, achieved by
sliding the focus ring forwards in the
direction of the arrow.

f=2.8 at full telephoto.
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Is a single widescreen
monitor better than a
twinned pair?
We tested a BENQ EX3203R to find out

L

ong ago in the distance past – the Moon might even have had water back then - I forked out, what was at the time, a formidable
amount of cash to buy a pair of 14” LCD monitors. I then coughed up
some more moolah for a pair of dedicated “swing arm” monitor stands
to plonk ‘em on.
I recall the total bill to be around the $1200 mark and the retailer in North
Ryde was Very Happy and went out and ordered a Porsche.
I have had lots of monitors since then of course, as well as ginormous all-inone screen computers from Dell; my current line-up is a 17” BENQ monitor
married to an OSEE dedicated video monitor all nailed to a Dell desktop.
And it got me thinking.
Of course, as everyone who edits video specifically, or dabbles in other
PAGE 10

BENQ EX3203R Wid

HARDWARE

descreen Monitor

creative pursuits using their PeeCee,
the more screen real estate you can
get the better, hence the dual monitor scenario. But these days, companies such as BENQ make widescreen
monitors, usually marketed at the
gaming types, so I wondered how
one of these would go in the video
editing world. And would the curved
screen design be a help, hindrance
or an immaterial factor in the editing
process?
Also to be factored in, as well as
screen real estate, was desk real
estate. Two monitors with their feet
takes up a lot of room.
I asked the nice folk at BENQ if they
could find it in their hearts to lend me
such a beast, and in a few days, a
very nice Model EX3203R turned up
on the Big Truck From The East.
BENQ describes this model thus:
“(The EX3203R combines) HDR with
B.I.+ Mode, which constitutes BenQ's
exclusive technology, the details are
brilliantly visible even while your eyes

are protected during gaming or video streaming.”
Technically, the EX3203R is a 31.5” 2K
QHD HDR monitor running at 144Hz
with a curvature of 1800R (this is a
fancy way of saying the radius is
1800mm and the ideal seating position is therefore also 1800mm from
the monitor).
Setup was a snip. Incidentally, the
box the EX3203R comes in has some
of the cleverest packaging I have
ever seen for a device like this, as
a hinged system means you don’t
have to tip things upside down, fight
with polystyrene versus cardboard
friction or resort to the trusty Stanley
knife and hacksaw combo as you do
with many others. Simply cut through
the sealing tape and the whole side
of the box drops down letting pull the
EX3203R out.
There are multiple HDMI, DisplayPort
and USB-C ports letting you also plug
in smart devices, Blu-ray players and
of course, gaming consoles.
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is a branch Pres of one of this State’s
Ulysses Motor Cycle Clubs, unlike other monitors, I ended without a massive headache, despite the screen
being slightly brighter than I would
have normally.
Apparently, there is a sensor built into
the EX3203R that detects ambient
light levels and colour temperature
of the environment and adjusts the
screen automagically accordingly.
Brilliant!

But my real interest was, as mentioned, in the EX3203R acting as an
editing monitor. And one of the features that caught my eye – pardon
the pun – was BENQ’s statement
that the EX3203R satisfied the global
safety authority, TÜV Rheinland’s certification for its flicker-free, low blue
light and ”Brightness Intelligence
PAGE 12

Plus” factors.
In short, they reckon you can use the
EX3203R for extended periods, which
of course while gamers do as we
know, but so do video editors. This Is
therefore very important.
And they were right. In a very extended session of editing for a mate who

And I also have to say the quality of
the imagery, especially HDR based
stuff is superb. With HDR now such an
important part of editing, this technology in your monitor is – or indeed
has – become a necessity. And while
it is not strictly speaking a 4K monitor,
but more like 2,5K, the frame rate capability is pretty damn good in compensation.
Now listen up here for a minute as
this is important.
Recently I have banged on about er-

HARDWARE
So, while at $750 or so the EX3203R
is not inexpensive when it comes to
basic monitors, the value lies in much
more than pretty pictures in my opinion. That is, this is NOT a basic $169
monitor, not by a long shot.
And bang for buck on a quick look,
the EX3203R is better than its opposition products such as those from
ASUS.

gonomics with regard to keyboards
and mice etc, but also of paramount
importance is of course eyesight. As
the years pass you by, you definitely
notice a degradation of eyesight, so
I reckon there is little sense in accelerating the process by having crap
habits and tools to go with ‘em.

In the 70s no-one told us about danger to the eyes from the harsh glare
of the Pilbara or Kimberley sun, and
now an entire generation is paying
the price. The same goes for the current generation who are staring at
screens all day as against squinting in
bright daylight.

Okay, if you are a top of the range,
dyed in the wool colour correction
expert video editor, you’ll go way
beyond the BENQ EX3203R into the
realms of the OSEE range for example (and BENQ make one too just
quietly), but for your everyday editor
who also likes to play a few minutes
of Call of Duty or Project Cars on
occasion, and wants a great monitor with plenty of screen real estate
for video editing, the BENQ EX3203R
would be high on my list.
Oh and yeah, as a bonus it frees up
a lot of physical desk space too.

PAGE 13

HARDWARE

$1600 for a keyboard? It’d better be d

D

ouglas Adams once said,
“Space is big. No REALLY

big”. (If you are a youngling, look up
the “Hitchhikers’ Guide to the Galaxy”. You’re welcome.)
And so, to paraphrase, the Blackmagic Design Da Vinci Resolve 16 keyboard is big. No, REALLY big.
The photo shows it next to a bogstandard Dell keyboard and you can
see what I mean.

Made of Steel
But there ain’t no flimsy plastic, string
and elastic bands nailing it all together in this baby. The Da Vinci Keyboard (I’ll abbreviate this to DVK from
now on) is all metal to start with (and
weighs accordingly) and Blackmagic suggests the keys are good for over
1 million operations each.
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Importantly, and I would suggest almost most probably uniquely, is that
all components are available as

spare parts giving the DVK an unlimited life-span.
Mind you, at AUD$1600+, you would

HARDWARE

damn good. (Hint, it is)

by David Hague

in reducing fatigue – a subject very
close to my heart right now of course.

Sculptured Keys
I love the sculptured keys as against
the more normally flat ones in use
today. They remind me very much
of what I consider the very best keyboard I have ever used, that from the
ill-fated Tandy Model 2000 in the 80s.
I have owned a LogicKey Vegas keyboard for about 15 years now and
like it very much indeed. But at the
end of the day it is a standard QWERTY keyboard with keys that relate
to shortcut commands colour coded
accordingly.

never treat or expect it to be a throw
away item.

One thing I do like, especially considering my current wrist affliction is that
there is a soft touch hand rest aiding

The DVK on the other hand goes way
beyond this, and Jacqui (my partner
who happens to be a keyboard wizard of the musical kind and a LogicPro
PAGE 15
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Jog Wheel / Controller
As you can see, there is an integrated jog wheel-cum-controller and this
is machined from a single piece of
metal giving extraordinary control for
jogging and trimming. To assist, the
jog/controller has a built-in electronic clutch and multiple roller bearings
giving extremely smooth scrolling forwards and backwards.
My only point of reference here again
is my well used and loved Contour
ShuttlePro 2, and as good as this is,
there is absolutely no comparison.

for the Mac aficionado) summed it
up nicely. You see, the DVK is not just
a keyboard. No, Jacqui said, it is a
workstation in its own right.

up, roll trans and so on. In this sense
it is akin to the Contour ShuttlePro 2’s
buttons that can be programmed
for certain tasks away from the main
keyboard, but the DVK is at a whole
As well as the standard QWERTY and
new level in this area.
Function keys, Blackmagic has designed it with dedicated keys for specialist tasks including in and out, close
PAGE 16

The only criticism I have of the jog shuttle controller is that it is on the right of
the DVK, as I prefer it left hand based
(even though I am right-handed) as
this means I can mouse and shuttle
at the same time. This is largely offset
by the functionality of the keyboard
itself though, as you can use your
right hand to control the position in a
clip being edited, and the left hand
to perform actions using the colour
coded short cut (and other) keys.

HARDWARE
Two of these “other” keys are Source
and Timeline. The Source key instantly
creates a virtual “source tape” of all
the clips in the bin in the current project and using this button, you can
simply scroll up and down all your
media meaning you do not need
to navigate potentially thousands of
clips.
The clip being viewed is also highlighted in the bin in real time and as a
bonus. switching between the source
tape and timeline is immediate. You
can also instantly resort all the clips in
the bin based on parameters such as
time, camera, duration and name.

and move again is a very fast way to
work indeed.

Except for the majority of users, there
The other innovations in the DVK lay- is no price, as the software is free (as
out and extra key functionality will, is its sibling, Fusion, but that’s another
I promise, revolutionise the way you story)
edit.

There's A Catch?

Conclusion

Da Vinci Resolve 16.1 is an aweIs there a catch? Well yes, sort of. But some editor. Throw the Da Vinci Reit isn’t a bad one by any stretch.
solve keyboard into the mix and it
becomes, for the professional, in my
The DVK is designed specifically to
opinion an almost unbeatable comwork with Da Vinci Resolve version
bination. Add Fusion and it is one hell
16.1 (or presumably any later verof a system.
sions) so if you are currently an AVID
Composer, Vegas Pro, Grass Valley All for the price of a 2-year subscripEDIUS, Adobe Premiere Pro, FCPX or tion alone to other NLE software.
other NLE jockey and have no intenAnd you still get not just a keyboard,
tion to change that state of affairs,
but almost a work of art to boot.
then save your pennies.

The sheer size of the controller means
that trimming is very precise and accurate and thoughtfully, there are
transition buttons allowing you to
But I strongly urge you, if you haven’t
switch between cuts and dissolves inalready, to download Da Vinci Restantly.
solve 16.1 (you can get it for WinThe workflow to get the best means dows, Mac and LINUX) and have a
you may have to modify what you look. This is no pretend NLE I promise
are used to, but the combination of you, and as you may have heard,
move, mark in, mark out, apply edit the colour grading capabilities alone
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are worth the price.

To get full details on the feature set
of the Blackmagic Design DaVinci
Resolve keyboard, see https://www.
blackmagicdesign.com/au/products/davinciresolve/keyboard

Show Me Yours ...

by David Hague

INTERVIEW

T

The WFX1 is used primarily
for
on the go
sporting
events
(motor
sport primarily) as it
Camera Equipment:
is small, light,
My day-to-day gear is based mostunobtrusive
ly around Panasonic camcorders,
and easy to carry around. And of
and which one I use is dependent
course 4K
on what I am shooting at the time.
Many shooters stick inside a single The PV100 has also been used for
discipline – docco, news, sport etc – sport where I need it to be tripod
but I get called to shoot various jobs mounted (a lightweight Velbon) or
and of course, we do lots of testing locked off, leaving me free to roam
of peripheral equipment. Because with the WFX1 for interviews and
of this I can switch between an HC- the like. I have also used it on shoots
WFX1 to an HC-PV100 or HC-X1 on for whale watching (in concert with
a GoPro Karma drone) and
a
regular
basis.
general fishing shoots
as the stabilisation
is excellent for on-

RX0, or a
GoPro 5 or
7 (My GoPro 6 is in
the Karma
Drone) getting the action / in-water

his is a brand new section in
which each month we’ll try and
bring you a story from a Australian
Videocamera reader on what equipment they use and why they chose it.,
To start the ball rolling I have volunteered myself …

water use. Usually in
these it is acting as
a primary camera
in partnership with a Sony

shots.
When I need to do a job that requires “serious” 4K work – usually interviews or events (presentations) or
when I make talking head tutorials,
I use the HC-X1 mounted on a Manfrotto tripod.

Audio:
The HC-PV100 and HC-X1 share a
Sennheiser MKE600 between them,
or for interview work, a Sennheiser
XSW-D Lav set (which when using
the WFX1 for sporting interviews
inthe-field is also brought
into the game). For
my own stuff – the
tutorials – I prefer to
use either the XSWPAGE 21
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D although I have also used my

Sennheiser Memory Mic system
in conjunction with my Samsung
7 phone (no, not the catchy-firey
version!).
For monitoring, a pair of Sennheiser
HD300 Pro cans are used.

Lighting:
My lighting requirements are very
basic thankfully. The PV100 has
a built in LED lighting system
which suffices for most purposes I need. If I do need a
light on either the WFX1 or
X1, I use a simple Aputure
A1M9 LED system.

VR/360°:
Frankly which I use here depends on my mood! I like
the Vuze and QooCam as
they both come with their
own desktop software for
pre-preparation of the subPAGE 22

sequent files for serious editing
in Vegas Pro 17 as well as Android apps to control them.
Similarly, the Ricoh Theta has
an app but has no desktop
software - but I do like the imagery
it produces. I have had a 360Fly for
a number of years, but these days it
is rarely used if I am honest, as the
others are superior in my opinion. I
would like one that is water resistant
I admit (again for fishing expeditions) as the waterproof housings
for any of them are horrifically expensive.

Other:
Very occasionally I use add on
filters (outside of ND filters that is)
for something specific and use a
Cokin kit with adaptors for each
of the three video cameras and
for a Canon 5D MK II. I have a
3rd party set of colour filters and
grads I bought through e-bay for
this purpose, mainly to mimic Top
Gear style backgrounds when I
went through a “phase”.

I

For stable work, at
this point I use a
GoPro 7 mounted
on a GoPro Karma
handheld gimbal,
but I admit in testing,
did like the newer
DJI gimbals and especially the Pocket
Camera (despite its
silly registration system!) with its built in
gimbal system.

A
selection of Joby tripods is in the Turtle case and a “secret weapon” I found years ago in
Vanuatu of all places, a G-Clamp
doubles as a tripod with a Manfrotto-like head which is
ideal for awkward
spots,
especially
clamping to the side
of a boat to get a
vertical shot straight
down into the drink!
For so-called action
camera work, I have

INTERVIEW

Conclusion:
selection
mounts
p u r c h a s e d
mainly via e-bay to mount
GoPros and others on to anything from a fishing rod to
the rear wing of my Monaro, windscreens, boat rails,
hats, chest mounts and
even one for SnorkyTheDog!

a
of

So, there you have it.
This collection has been built up over the last 20 years, but I freely admit, despite the diversity of equipment, like you, I am sure, there is always some desirable piece of kit I still want!
I just haven’t seen it this week as yet

A specialist mount
from UK based Hague
Camera Mounts (no
relation I assure
you) is used for
car mounting via
a huge suction syst e m
and another from Hague mounts to
seat head restraints.
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Cinema 4D
Tutorial

Section 1

Denby Smith

TUTORIAL

Parametric modelling, tools and techniques for creating scene assets.

W

elcome back. I hope you had
some success toying around
with what we learned last time
and I imagine you started figuring
out a few other things too.
Great, because now we have some
work to do.

You’ve got to have a plan. It helps
you stay on track and eliminates a
lot of the back and forth involved
in making ground level creative decisions which, when working in 3d,
adds up to a lot of wasted and unsatisfying time.

Now thinking about our sci-fi scene,
we need to create a collection of assets which we will bring into our main
scene when we create it later. To begin with, we need some structures;

Ultimately, you want to reserve that
energy and channel it into the really
interesting creative decisions down
the track as your work begins to take
shape.

Some kind of habitat, a space port,
communication tower, somewhere
for ships to dock. The habitat seems
like a good place to start.

1. Habitat sketch showing zoom out
view of both		

Now, here’s the hot tip! Go to town
creating things, getting inspired and
making even more things.
But, all good 3D work starts off the
old-fashioned way… Paper and pencil.

2. Spaceport sketch

So, I sketched up some ideas, reshuffled a few things and came up with
this, a fairly simple hexagonal concept.
One of the things I love about modelling in 3D is how simple it is to copy/
paste geometry so by using this repeated shape it means that we can
reuse a lot of what we do to make
a bigger, more complex scene without giving ourselves too much extra
work.
That said, I decided to have separate
spaceport and habitat areas linked
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by a kind of monorail, so we can add 3b.Oil Tank with 6 Rotation Segments
some animation later on. So, this is
what I’ll be working on throughout
the series, but as you gain skills and
confidence you will add your own
ideas, creating your unique world.
OK let’s get started building our structure, the first component is the hexagon. Create an ‘Oil Tank’ from the
‘Primitives’ menu and go down to Make the Object editable and scale
the attributes panel and under the down the ‘Y’ axis so looks a bit flatter.
‘Object’ tab reduce the amount of
4a.Adding Multiple Oil Tanks
‘Rotation Segments’ to 6 giving us a
nice hexagonal shape.
3a.Oil Tank with 32 Rotation Segments 		

Now create another Oil Tank, move
it to the side, make it editable and
scale up the ‘Y’ axis so it becomes
long and thin. Then to scale the object down on all axis, just click anywhere on the screen and drag down
until it’s roughly the same height as
the hexagon.
You can compare the heights of
each object using the Coordinate
panel. Set it to ‘Object (Rel)’ note
an object’s ‘Size’ value in the ‘Y’
dialogue, then do the same with the
other. Now go up to the ‘Cameras’
menu and select ‘Top’. Now we can
see a flat 2d image of our workspace
viewed from above.
5a.using the Top View

4b.Scaling Oil Tank
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5b.Lining up by eye with grid lines

6b.Placing objects		

Using this and the side views can be
really helpful when you are trying to
be accurate. In this view you cannot
move in 3D so use pan and zoom.
Move the small Object over until it
touches the corner of the Hex object
then hold CTRL and move the copy
up and to the right, aligning it with the

Now go back to the ‘Perspective’
camera view and have a look.

7a.Selecting multiple instances

7b.Using ‘Connect Objects + Delete’

Now is probably a good time to start
naming the objects in our scene, as

you can see the ‘Object’ panel is filling up with Oil Tanks 1-6 which is not
really helpful.

next corner. Repeat this for all corners Double click on the lowest Oil Tank in
using the grid and geometry lines to the list, the first one we created, and
help line things up.
name it whatever will make sense to
you, I’ll just name mine ‘Main’.
6a.Copy Pasting objects
With the others I don’t think we will
need individual access anymore so
let’s combine them into one by selecting them all, right clicking and
selecting ‘Connect Objects + Delete’.

We can still edit them as normal, but
we have saved a little real estate
and made things a bit clearer. Now
rename this ‘Columns’. Lastly let’s cut
off the bases of the columns so that
they sit flush with the base of the hexagonal object.
In ‘Polygon’ mode use the rectangle
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selection tool to select all the faces
making up the curve at the bottom
of each column and delete. Choose
‘Select’ from the main menu and go
down to ‘Loop selection’. In ‘Edge’
mode, select the perimeter edge at
the base of one of the columns and
see how all the connected edges
are selected too, Loop and Ring select are great tools. From the ‘Mesh’
menu go to ‘Create Tools’ and select
‘Close Polygon Hole’. Hover over the
‘Edge’ until the hole highlights and
click.

This creates a new polygon face
connected to the unattached edges, completing the object boundary.
8a.Using Loop select		

8b. Closing Polygon Holes

9a. Copying section of geometry

OK, so let’s get a bit fancy. Choose
the ‘Live Select’ tool located next to

9b. Selecting and Deleting excess
geometry

‘Move’ and just click and drag to select all the faces on the top of the
hex object.

This is a great tool but always be sure
you have a good view of what you
are selecting so as not to select any
unwanted geometry. This becomes
increasingly important with complex
geometry. If you do select something
you don’t want, you can just hold
CTRL and deselect it, then continue
to ‘Live Select’ by holding SHIFT. Pretty standard selection stuff.

With all the top faces selected, copy
and paste then move up it in the ‘Y’
axis. Now we have a copy of the roof
section. But there is an unseen problem. If we go into ‘Object’ mode now
and drag the roof further upward,
you can see the rest of the Oil Tank is
still connected.
Drag it right up until you can see the
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whole object. Now go up to the se- the columns and scale it up slightly so
lect tool, click and hold to see more the corner tips overhang the peaks
options. Choose ‘Rectangle Selec- of the columns. This might look ok
tion’ and go to the camera menu however the roof section is actually
and choose a side view, Right, Left, only a one-sided ‘Plane’ and not a
Front or Back any will do and drag complete polygonal object.
the marque around the bottom secIn some cases, you can use one sidtion of our copied Oil Tank. Hit Deed ‘Planes’ but that’s a story for anlete.
other time. There are many ways to
One issue we have is that our objects deal with this, but let’s just go with the
‘Local’ pivot point is still at the original quickest easiest (cheapest) solution
position, so we have to fix this now. for now by closing polygon holes, like
Over on the left toolbar below ‘Pol- we did earlier.

ace, from a film… far far away.
Now let’s get the scale right before
we turn it into something more substantial. Create a cube, set its size to
1meter and place it next to the building. As you can see, at this point our
building is a little on the small side so
scale it up by around 500.
10a. Using
scale

1m

cube

ygons’ selection mode is the ‘Axis

This time however we won’t bother
Modification’ tool which allows us to
with ‘loop select’ as the tool automatreposition our pivot point. Click to enically recognizes unattached edges
able it, then drag the ‘Y’ axis handle
causing holes. Just go to ‘Mesh’ >
up to the center of the Roof object.
‘Create Tools’ > ‘Close Polygon Hole’
Now it is vitally important to disable and hover over the ‘Edge’ until the
‘Axis Modification’ immediately after hole highlights and click.

10b. Scale up x500

performing this action. Otherwise you
Great work, you have now made a
will modify axes all over the place
custom piece of geometry.
and wind up very confused. Now, rename it ‘Roof’.
And begun work on the first asset in
your Sci-Fi scene. Kinda reminds me
Back in ‘Perspective’ view move the
of a certain slug like character’s palroof down to the height of the top of
PAGE 29

to

check

TUTORIAL
That’s better, now we need to create 12. Extrude Inner tool
the tunnel that connects the mod-

14. Select new tunnel section

ules of our habitat. Zoom in to get a
good look at one of the outer walls
and using ‘Polygon’ mode, select 3
faces of the lower part of the wall, I
chose to leave the very lowest face
unselected so the tunnel is raised off
the ground but that’s up to you. Go
up and select ‘Mesh’ > ‘Create Tools’
> ‘Line Cut’ then, by clicking to create points, draw out a shape within
the selected faces, remembering to
close the shape by ending on the first
point.
11. Line cut tool

With the faces inside the new shape
selected, go up to ‘Mesh > ‘Create

Tools’ > Extrude Inner’ and hovering

over the selection, click and drag the
mouse just the slightest bit to the left.
Now, again select the inside faces
and this time choose ‘Mesh > ‘Create Tools’ > Extrude’ and drag the
mouse to the right. This new geometry will become our tunnel.
13. Extrude tool

PAGE 30

Before we move on though we need
to tweak where the tunnel joins the
wall. So, select all the faces of the
new tunnel section and scale it
down a little on all axes, then move
it out along the Z axis. Much better.
15. Scale down tunnel section

TUTORIAL
16. Move tunnel along X axis to complete joining section.

17. Select end faces

19. copy objects

18. Bevel tool

20. Scale down objects

OK. Now we are ready to expand
this hexagonal lollypop into a functional off-world Habitat Complex. Use
the ‘Top’ view again for this process.
Select the whole object and create
two copies by either using Ctrl+ C &

This will indicate the original hexagon is the main building and give it
some dominance. Now we need to
use ‘Rotate’ and ‘Move’ to position

Now on the other end of the tunnel
we are going to do it a little differently. Select the end faces then go
up to Mesh > Create Tools > Bevel,
(depending where you click the
mouse, you can get very different,
very strange results with this tool) so
hover over one of the edge lines until it highlights. This step involves two
mouse moves, first click on the highlighted edge line and drag along the
X axis, then using the mouse wheel
scroll up along the Y axis, creating a
nice bevel just like our first one.

them, so the end of the tunnel section appears to connect with the corCtrl+ V or click and drag while hold- responding wall, of course if we were
ing down Ctrl and place one either intending to add interior shots to our
side of the original and scale them animation we would have to weld
these section together properly, howdown, about 70% should do.
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ever as we are only looking for exterior shots we just need to make sure
there are no visible gaps between
the meshes. Because we are using a
six-sided hexagonal shape, rotations
are easily calculated, so select the
left-hand object and instead of using
the rotate tool, go over to the ‘Attribute’ panel and in the ‘coord’ tab type
-120 (minus 120 degrees) into the top
dialogue box in the rotate column
(R.H).

one more copy and, sans rotation, ly, to change the orientation of a porepeat the process for the lower sec- lygonal objects center axis or pivot
point. This is easily done by selecting
tion to complete the structure.
the ‘Axis Modification’ tool from the
Now back to perspective view and
‘Selection Modes’ menu on the left.
have a look at your work!
Simply click to enable, then use the
usual ‘Move’ and ‘Rotation’ tools to
21. Rotate +/- 120 degrees.
adjust to your needs. Be sure to disable it immediately after use as it will
continue to alter anything selected
which can be very frustrating.

Next go over to the ‘Selection Modes’

23. Basic model complete

toolbar, click and hold the magnet
icon or ‘Snap’ tool. From the flyout 22. Use Polygon Snapping to align
menu click ‘Enable Snap’ then also objects
select ‘Polygon Snap’. Ensure you
have the end faces of the tunnel selected and drag toward the wall until
its snap up against it you may want
to change view back to ‘Perspective’
while doing this as it can be tricky to
get a good eyeline.

Fantastic! Our off-world habitat is
well and truly on its way. You should
already be starting to get the hang
of navigating in 3d space and findRepeat with the right-hand object, Tip: It can often be necessary, par- ing your way around the C4D interremembering to rotate by positive ticularly in cases such as this where face, which is really the most imporvalue of 120 this time. Finally make our objects are positioned diagonal- tant step. In the next part of this series
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we will continue the techniques we
have used here and introduce more
advanced concepts to create more
unique assets.
In the meantime, keep practicing
the techniques we have covered so
far by having a go at modelling the
spaceport.
There are no rules to what it must look
like just be sure to include a kind of
train platform for our terrestrial transport vehicle to dock at. At right is
what I came up with using only the
techniques covered so far.
For cohesion I continued with the
Hexagonal shape, increasing the ergodic value of our world.
OK have fun. 'Til next time.

If you don't have a copy of Cinema 4D, download a fully working trial version for Mac or PC at www.maxon.net.
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Review: DJI MAVIC MINI (Pt 1)
Baby drone packs a
wallop in a teeny, tiny
light weight package.

T

he DJI Mavic Mini is the company’s latest kid off the block
– although in this case the term
“kidlet” is more apt. It is tiny, but
still technically packs a punch.
I am doing this review in a couple of
parts (at least), as it warrants a little
more than a simple review I feel. This
is because the DJI Mavic Mini could
be the most important drone – commercially for them – that DJI have
made to date. And there is a lot to
explore.
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tralia region between high and low
tide.
But that cost a coupla grand, putting it out of the reach of many, thus
leaving a price hole for the knock-off
manufacturers to plunder with infe-

Over the years I have tested many
drones from various manufacturers
such as Parrot, GoPro, Dobby, and
Swann but none of these has come
even close to what DJI has offered in
the past.
The last DJI drone I tested was the
original Mavic which I took up to
Broome and zipped it around the tidal beaches for some fun, and even
made a couple of videos at Eco
Beach Resort showing the differences
up in the Kimberley of Western Aus-

rior product. The Mavic Mini is only
$599 though and from only a single
2 minute flight shows its quality and
capability in comparison. The knockoffs cannot even hope to compete.
My benchmark comparison for drone

DRONES
testing, which many may scoff at as
I admit, this was not a commercial
success, is my GoPro Karma. Why is
it the benchmark? Quite simple; I
can take it out of its case, press the
starter’s button and assuming all is
fully charged, it just works. There is

ed controller to do its thing. And I do this cable and get into the slot of the
find some aspects of this a little fiddly. controller.
You see, a cable is used to connect
from the controller to the charging / comms port on your phone
and hence to the DJI Fly software

Once that is done, you do need to
pair the controller to the Mavic Mini,
or more correctly, I had to. I would
have thought this was automatically

no need to use a smartphone as a
installed. I just find this cable, which
pseudo controller as it has a dedicatcan be USB-C, mini-USB or a Lightning
ed one with its own LCD screen, and
cable with all three supplied, quite
I like this.
short, and with the Huawei P9 phone
In comparison, the Mavic range, in- I was using (my own Samsung Galaxy

done at the factory, but there you
go. Prior to this though, both units
need to be turned on and unless you
have Mavic experience or read the
manual (which wasn’t in the box and

cluding the Mavic Mini uses a combo
of your smartphone and a dedicat-

7 is not that flash in bright sunlight) had to be downloaded), this basic
was a bit o’ a bastard to setup with step alone will drive you nuts!
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It is not as simple as just pushing the
go button on each of the controller
and drone as would be (seemingly)
obvious. Oh no. You have to press
once, let go and then do a press and
hold on each to actually get the engines firing.

that need GPS and the like to be both at.
able do the party tricks their masters
Despite these criticisms, they are in
have instilled in those clever little silithe overall scheme of things quite
con chippy things on board.
minor, and I only mention them here
But I think a better pre-first-ever-flight to pre-warn potential buyers of what
cheat sheet would be a good idea to expect.

so as to prepare the newbie user for
Aha! Success you think, until you see the sequence(s) needed.
a warning message on screen letting
It’s a bit like getting a new toy for
you know the firmware is out of date
Christmas only to find it needs batterand therefore has to be updated beies and all the shops are shut.
fore you can fly.
This takes another 15 minutes or so
and even then, you cannot just walk
outside and go for a leisurely spin
above the treetops.
First, I had to set the compass by doing a drone vertical and horizontal
orientation.
Then and only then can you navigate the software and actually get
the thing in the air.
Now, for the seasoned drone users
out there, I know this stuff is mostly the
norm for the more advanced drones
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In the bigger world, the Mavic Mini is
a fabulous piece of kit with capability way beyond what you’d expect
from the price tag.

I know you’d sort of expect that by
“Yes you can play with it Johnny, just now, with it coming from the brains
of a company with a pedigree in this
not straight away…”
area that is now just about without
My review unit also came with oppeer. But it is still really nice to be surtional prop protectors, and whilst a
prised.
5 year old who is au fait with Hungry Hippo or Mousetrap will tweak More on the actual capabilities and
straight away how to fit them, many flying experiences in the next instalwill need to hunt down the YouTube ment (only caused by the fact at the
moment here after 10 days+ of glorivideo I suspect.
ous above 30 degree windless days,
They are akin to those puzzles of yore,
we have lots of bushfire smoke and a
where two seemingly simple blocks
stiff breeze which is not conducive to
are put together to make a pyramid,
mini drone flying obviously).
but you go insane working out what
are the correct angles to place them And I can’t wait!

Audio for
Action
Cams ...
by David Hague
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I

love using so-called “action
cameras”. You know, GoPros
and models from DJI, Sony and
countless “knock-off” brands.

gritted teeth vision, is almost always
loud gasps, cheers, screams, yells
and even downright terrified sobbing at times. Shouldn’t this also

That’s cause I have habits of throwing cars around race tracks and dirt
roads, attempting to catch a piscatorial feast in the briny or simply
paddle around coral reefs with
a snorkel, mask and fins (they
are NOT flippers!).

various action cam type forums
leading us to the opinion the general
consensus is that GoPro audio sucks
(not necessarily our opinion I hasten
to add), we have used this as a basis
to see just what can be done

But there is somewhat of an issue with action cameras in these
sorts of circumstances in that audio in many cases seems to be a
secondary thought.
Sure, I understand that what they are
really designed for is to be a camcorder with a small form factor and
a wide lens to capture, well, action,
in places and angles that a “normal”
camera or camcorder cannot possibly hope to achieve.

be captured for the posterity of
the event, no matter how
embarrassing it might be
after the fact?
‘Cause we do!

But along with that hair-raising, stom- Now, with GoPro having the majority
ach churning, bum-cheek clenching, of this market, and a snoop around about that situation, without necessarily adding a huge bulky mic to the
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camera, or worse, making it that it
just cannot do what it is best at and
being attached to things other than
a tripod eg you head, arm, chest,
bike, car, go-kart, surfboard, skis, fishing rod, boat etc.

For best results, we recommend using the
standard GoPro skeleton mount so you
can still attach the
camera to one of the
many accessories available
from both GoPro and 3rd party suppliers, as this leaves the
ports available to use via cutouts in the mount design.

You can of course add a standard
type mic to a GoPro using the available mic adaptor which plugs into
the charging port, converting it into a
3.5” headphone type port, and then
use something If you prefer to have a more discreet
system, then a wireless lav setup
might be better, keeping the mic
clipped to a collar or similar, and the
receiver via a cable connector to
the camera.
However, a major problem exists in
one area. If you want to shoot in a
wet area – rain, snorkelling etc – then
waterproofing is of course paramount
and using any of these mics is not going to work. This means you are stuck
with using the correct housing for the
camera for this environment and its
turers including RØDE, Sony
native inbuilt mic sadly.
and Shure.
such as a Sennheiser
MKE400 or MKE 440 shotgun mic (which actually appear on the
GoPro recommended list along with
some other manufac-
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But!
If you can get
your hands on a GoPro Hero 4 Silver via ebay, Gumtree or
wherever, then Sennheiser do make
a dedicated mic for this camera
that is waterproof called an MKE 2
Elements that costs around AUD$80.
The MKE 2 Elements has an interface
board that allows it to become a
part of the main camera body and is
very effective.
Just make sure if you order one, you
specify the word ”Elements” very
clearly as the MKE 2 without the “Elements” is a very different beast entirely!

